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UTILISATION DE LA SUITE ALLEGRO® (CADENCE™) POUR LA SAISIE DE 

SCHEMA ET LE ROUTAGE DE PCB
1
 

 

  

 

 

Nous décrirons dans ces quelques pages les bases de l’utilisation du logiciel de saisie de schéma, de 

simulation analogique de circuits électriques et de routage. Il s’agit d’un résumé des fonctions de 

base pour s’initier à cet outil. 

                                                 
1
  PCB = Printed Circuit Borad (Circuits imprimés) 



3                                                            Utilisation de la suite ALLEGRO® / G.Amendola, C.Chiang, P.Poulichet         

 

Table des Matières 
 

 

 

1. Organisation typique d’un logiciel de routage............................................................................. 4 

2. Saisie de schéma et simulation électrique ................................................................................... 4 

2.1. Création du projet ................................................................................................................ 4 

2.2. Ouverture du schéma et placement des composants............................................................ 6 

2.2.1. Placement des composants .......................................................................................... 6 

2.2.2. Placement des connexions entre composants .............................................................. 7 

2.2.3. Placement de la valeur d’un composant ...................................................................... 8 

2.2.4. Placement de la masse ................................................................................................. 8 

3. Attribution des empreintes des composants ................................................................................ 8 

4. Création d’un nouveau symbole sous Schematic Allegro et association d’un modèle spice .... 10 

4.1. Création d’une nouvelle bibliothèque................................................................................ 10 

4.2. Création du symbole du composant................................................................................... 10 

4.3. Association d’un modèle spice .......................................................................................... 11 

4.4. Déclaration de la nouvelle bibliothèque ............................................................................ 13 

5. Routage avec PCB Editor .......................................................................................................... 14 

5.1. Création de la Netlist ......................................................................................................... 14 

5.2. Initialisation des répertoires............................................................................................... 14 

5.3. Organisation des menus et des options :............................................................................ 16 

5.3.1. La fenêtre de travail de PCB Editor:.......................................................................... 16 

5.3.2. Les barres d'icônes:.................................................................................................... 17 

5.3.3. Les panneaux de contrôles:........................................................................................ 18 

5.3.4. La barre des coordonnées et commandes: ................................................................. 18 

5.4. Zoom.................................................................................................................................. 19 

5.4.1. La fenêtre de visualisation:........................................................................................ 20 

5.4.2. Touches de fonctions, raccourcis et modes d’édition :.............................................. 20 

5.4.3. L'onglet « Options » du panneau de contrôles: .......................................................... 20 

5.4.4. La liste d'objets sélectionnables:................................................................................ 21 

5.5. Création des pastilles ......................................................................................................... 22 

5.6. Création des empreintes..................................................................................................... 23 

5.6.1. Visualisation d’une empreinte ................................................................................... 23 

5.6.2. Création d’une empreinte (en utilisant le « package wizard »).................................. 24 

5.6.3. Exemple de création d’un DIP 14.............................................................................. 26 

5.7. Importer la netlist de Design Entry CIS dans PCB Editor:................................................ 28 

5.7.1. Partir de PCB Editor .................................................................................................. 28 

5.8. Conditions préalables au placement .................................................................................. 28 

5.9. Placement Manuel ............................................................................................................. 29 

5.9.1. La grille de Placement: .............................................................................................. 29 

5.9.2. Les commandes de placement: .................................................................................. 30 

5.10. Le Chevelu..................................................................................................................... 32 

 

 

 

 

 



4                                                            Utilisation de la suite ALLEGRO® / G.Amendola, C.Chiang, P.Poulichet         

 

 

1. Organisation typique d’un logiciel de routage 
 

Les logiciels de routage sont organisés quasiment de la même façon c’est à dire que les mêmes 

étapes doivent être franchies avant de concevoir un circuit imprimé. 

Ces étapes quelles sont elles ? 

� Saisie de schéma avec le logiciel Design Entry CIS dont le résultat est celui montré sur la 

gauche de la Figure 1. 

� Définition de la forme du composant dans le schéma par Library Explorer. Le circuit PIC 

16F873 a été dessiné sous le gestionnaire de « Library ». 

� Attribution des empreintes de composants (footprint) ou spécification des boîtiers en 

relation avec le schéma. 

� Génération d’une liste de connexions entre les composants appelée Netlist. 

� Chargement de la netlist et placement des composants sur le circuit imprimé à gauche sur la 

Figure 1. 

� Routage c’est à dire placement des connexions entre les composants. On obtient alors un 

circuit imprimé ou un PCB pour (Printed Circuit Board). 

 

 

Figure 1 : schéma électrique et carte routée 

 

2. Saisie de schéma et simulation électrique 

2.1. Création du projet 

En premier lieu la structure conseillée de répertoire d’un projet de conception de carte est la 

suivante : 

 
Le répertoire Capture contenant tous les schémas (sous forme de projets .opj) 

PCB editor contiendra les différentes implantations de cartes que vous aurez réalisées 

lib_esiee comprends les empreintes ou foot print (répertoire « packages ») adaptées au procédé de 

fabrication de l’école (double face sans trous métalisés), les pastilles (répertoire « padstacks ») 

utilisées soit par les « foot print » soit dans le routage de la carte,  les symboles de composants 

(répertoire « symbols ») et enfin les différents formats de cartes (répertoire « boards »). 
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Le lancement de l’outil de création de schéma se fait par le menu Démarrer => Programmes => 

cadence => SPB16.5 => Design Entry CIS.  

 

 

 

La fenêtre montrée en Figure 3 ci-dessous apparaît. Faire File > New > Project pour créer un 

nouveau projet. Un projet est un ensemble de plusieurs fichiers (schéma, bibliothèque de schéma, 

bibliothèque de PCB et PCB) qui serviront à générer le PCB. 

 

 

Figure 2 :  

 

Figure 3 : ouverture projet 

 

 
 

Figure 4 : ouverture d’un projet blanc 
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L’ouverture d’un projet blanc créer un nouveau projet sans aucune liaison avec les autres fichiers. 

Il est aussi astucieux d’utiliser un « projet type » dans lequel les bibliothèques sont déjà définies.  

 

2.2. Ouverture du schéma et placement des composants 

 

Après les étapes ci-dessus, le schéma s’ouvre directement comme le montre la Figure 5. Les 

composants du schéma seront placés sur la fenêtre schematic. 

 

Figure 5 : ouverture schéma et fenêtre du schéma 

 

Pour ajuster le niveau de zoom, taper I (In) ou O (Out) agrandir ou diminuer de taille. 

2.2.1. Placement des composants 

 

Avec la fenêtre du schéma active (en cliquant sur la bande horizontale de la fenêtre du schéma), les 

menus du haut sont modifiés et Place > Part (Shift P) ou  permet d’ouvrir le bandeau montré 

sur la Figure 6. Il permet d’accéder aux bibliothèques déjà installées (ici ANALOG, LIB_ESIEE, 

Design Cache). Pour ajouter une bibliothèque cliquer sur le rectangle pointillé.  
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Figure 6 : ouverture d’une bibliothèque de composants 

 

Quelques bibliothèques courantes : 

 

� Pspice>Source pour les générateurs de tensions et courants : vsrc > source de tension 

continue, impusionnelle ou sinusoïdale, vsin > source de tension sinusoïdale avec 

offset, vpulse > source de tension rectangulaire. 

� Pspice>Analog résistances R, condensateurs C, inductances L (K_linear pour les 

mutuelles inductances), générateurs liés de tension ou courant commandés en tension 

ou courant E - F - G - H, 

� Pspice>ABM : additionneurs SUM, soustracteurs DIFF, dérivateurs DIFFER, filtres 

BANDPASS - BANDREJ... 

� Opamp pour placer les AOP (LF 356, LM 358…), 

� Pspice> Analog : bibliothèque générique comportant résistances, capacités, diodes, 

transistors, connecteurs, relais… 

Les bibliothèques contenues dans le répertoire Pspice comportent des modèles de simulation 

associés aux symboles. 

Une fois le composant sélectionné on retrouve un second icone  qui permet de le placer 

définitivement. A l’aide de la clé de gauche ou la barre d’espace, on le tourne avec Shift + R 

(Rotate) et on termine le placement par Esc. 

Il est à remarquer qu’une fois qu’un composant a été sélectionné dans un schéma, il apparaît ensuite 

dans la bibliothèque « Design Cache ». 

 

2.2.2. Placement des connexions entre composants 

 

Fils de connexions 

Menu Place > Wire ou Shift W ou . 

Bus de liaisons 

Menu Place > Bus ou Shift B ou . 
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Pour tracer une liaison, suivre le tracé du fil avec la clé de gauche. Pour annuler, clé de droite et End 

Wire. Il est parfois utile de nommer un fils de connexions par Place > Net Alias ou  pour pouvoir 

retrouver facilement son niveau de tension dans les résultats de simulations. 

 

2.2.3. Placement de la valeur d’un composant 

 

Il est possible de cliquer sur trois endroits du composants. Par exemple sur la figure ci-dessous : 

 

Figure 7 : Placement de la valeur d’un composant 

 

R1 est le « Part Reference » du composant obtenue en cliquant sur R1. 

1k est sa Value. 

En cliquant sur le corps de la résistance, on accède à une ligne et il est possible de modifier le « Part 

reference » et la « Value » mais c’est moins pratique. 

 

2.2.4. Placement de la masse 

 

Place => Ground => CAPSYM => 0 

 

 

3. Attribution des empreintes des composants 
 

On peut sélectionner un à un chaque composant et attribuer l’empreinte (PCB footprint) sur la ligne 

qui apparaît. On peut également sélectionner plusieurs composants, ou bien tous les composants par 

Ctrl A puis faire Edit > Properties (ou Ctrl E) et on accède (en sélectionnant l’onglet Parts) à un 

tableau similaire à celui de la figure ci-dessous. 
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Figure 8 :  Tableau des empreintes 

 

Modifier la colonne PCB Footprint en indicant le nom de l’empreinte que vous pourrez trouver (par 

exemple) dans le répertoire libs_esiee => packages  (voir exemples dans le tableau ci-dessous). 

 

Référence PCB Foot print 
Condo chimique esiee_cap_chi_200 
Condo à 2 pas esiee_cap_200 
Condo à 3 pas  esiee_cap_300 
Résistances esiee_res_500 
Diodes esiee_diode_500 
Transistors to18 esiee_to18 
Potentiomètre esiee_pot 
CI Dip 8 esiee_dip8 
CI DIP 14 esiee_dip14 
Connect vers le FPGA 
(EL213) 

esiee_conn_basys_v2 

Connecteur 2   pastilles esiee_conn_x2 
Bornier x3 
(pour alimentations) 
 

esiee_bornier_x3_ 300mils 

LED esiee_LED_100 

Microphone (EIG1001) esiee_mic_100 

Tableau 1 : Tableau de quelques empreinte « ESIEE » 
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4. Création d’un nouveau symbole sous Schematic Allegro et 

association d’un modèle spice 

4.1. Création d’une nouvelle bibliothèque 

 

Utiliser la bibliothèque locale (par exemple lib_esiee) ou en créer une nouvelle. Pour une nouvelle  

bibliothèque faire File > New > Library (l’attacher au projet courant). Le nom par défaut est 

library1, changer son nom en cliquant sur l’onglet portant le non du projet (ici « el213 ». Dans la 

bibliothèque choisie (la nouvelle ou lib_esiee), sélectionner avec la clé de droite et faire New Part. 

 

Figure 9 : Création d’une nouvelle bibliothèque 

4.2. Création du symbole du composant 

 

Nous allons créer le symbole qui va apparaître dans le schéma (appelé Part dans Allegro). Nous 

associerons le modèle spice pour pouvoir simuler le composant. Les fichiers utile sont : le fichier de 

la liste des composants (ou Part) avec l’extension .olb et le fichier modèle spice avec l’extension 

.lib. 

 

Se placer dans la fenêtre Hierarchy et dans la bibliothèque dans laquelle on veut créer le nouveau 

composant. Faire New Part avec la clé de droite de la souris. Tracer le symbole comme sur la Figure 

10 à l’aide de Pin (Place Pin) et de ligne (Place Line). La référence du Part, le nom des broches et 

leur numéro doit être exactement celui du modèle Spice. Sauvegarder le Symbol créé.  

 



11                                                            Utilisation de la suite ALLEGRO® / G.Amendola, C.Chiang, P.Poulichet         

 

 

Figure 10 : création d’une bibliothèque et création d’un nouveau symbole (Part) 

 

Sur la Figure 10, on a montré la création d’un symbole d’un transistor MOS. 

4.3. Association d’un modèle spice 

 

Les modèles Spice sont placés dans le répertoire suivant : 

C:\Cadence\SPB_16.5\tools\pspice\library\nom.lib. 

 

Ouvrir le logiciel Model Editor à l’emplacement : Cadence > Release 16.5 > AMS Simulator > 

Simulation Accessories > Model Editor. Choisir l’option Capture. Ouvrir la bibliothèque dans 

lequel on veut ajouter le composant (users.lib par exemple). Puis avec le menu Model > Copy 

From, la fenêtre de la Figure 11 s’ouvre. Dans la ligne New Model, donner un des noms proposé en 

dessous. 
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Figure 11 : Model Editor et fichier spice 

On obtient alors une bibliothèque avec un nouveau nom de composant qui peut être utilisable dans 

la simulation. 

 

 
 

Figure 12 : nouveau composant dans la bibliothèque 

Nous allons maintenant associer le symbole créé et le modèle spice. A partir du répertoire de la 

fenêtre hierarchy suivre la Figure 13. 
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Figure 13 : association du modèle spice et définition du Pin Mapping 

Dans Matching Model, choisir le nom du composant puis suivant. Puis associer les broches du Part 

et le nom dans le modèle Spice. 

 

4.4. Déclaration de la nouvelle bibliothèque 

 

Il est indispensable, pour déclarer la bibliothèque que l’on vient de créer, de faire Pspice > Edit 

Simulation Profiles > Configurations Files puis avec Browse, choisir le fichier USERS.lib. Cliquer 

sur Appliquer. 

 
 

Figure 14 : déclaration de la bibliothèque 

Il peut arriver que l’on doive mettre à jour la bibliothèque de composants ce qui s’obtient à partir de 

la fenêtre hierarchy : Design Cache > Cleanup Cache. 
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5.  Routage avec PCB Editor 
 

Avant de passer sur l’outil « PCB Editor » il faut d’abord créer la netlist décrivant le schéma saisi 

dans « Design Entry CIS ». 

5.1. Création de la Netlist 

Cette opération se fait encore dans la fenêtre de « Design Entry CIS ». 

Cliquer sur l’onglet portant le nom du projet (par exemple « el213 » ou « eig1001 »). Le menu dans 

le bandeau du haut est alors changé. 

 

Figure 15 : création de la « Netlist » 

 

Aller dans le menu Tools > Create Netlist. La fenêtre de droite s’ouvre. On peut définir un 

répertoire spécifique ou écrire la netlist (par exemple « allegro »). Une fois cette netlist créée elle 

sera importée dans « PCB editor ».   

 

On ouvre maintenant l’outil PCB Editor (à partir des Menus de Windows). 

5.2. Initialisation des répertoires  

Cette opération a pour but d’indiquer à l’outil où aller chercher les pastilles (padstack) et les 

empreintes (package) lors de l’importation de la netlist.  

Si cette configuration  n’est pas faite il apparait une erreur au moment de l’importation de la netlist.  

Choisir le menu : Setup => User preferences  



15                                                            Utilisation de la suite ALLEGRO® / G.Amendola, C.Chiang, P.Poulichet         

 

 

Figure 16 : Menu des préférences 

 

Ajouter dans les chemins de « psmpath » et padpath » les bibliothèques de pastilles et les 

bibliothèques de symboles et aussi (éventuellement) des cartes vierges (borads). Il est conseillé 

d’ajouter les deux (ou trois) bibliothèques dans chaque « path ». Dans l’exemple d’organisation des 

répertoires du §2.1 les chemins sont : « repertoire de travail=> lib_esiee=>packages et  repertoire 

de travail=> lib_esiee=>padstack ». le répertoire courant peut être indiqué « .\ ». 

 

 
 

Figure 17 : Ajouter une bibliothèque 
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5.3. Organisation des menus et des options : 
 

� La barre d’icônes. 

� La barre d’outils de placement, de routage, d’affichage. 

� La fenêtre d’état. 

� Le panneau de contrôles, l’onglet des options varie suivant la commande 
active... etc.  

 

Faites glisser le curseur de la souris doucement sur les icônes de façon à voir apparaître 
une petite fenêtre vous indiquant le nom de l’outil auquel correspond l’icône. 

Continuez à faire glisser le curseur sur les boutons Visibility/Options/Find, les fenêtres 

respectives doivent apparaître puis disparaître à partir du moment où le curseur n’est plus 

dans la géométrie de la fenêtre concernée. Si vous avez cliquez sur le bouton alors les 

fenêtres restent positionnées dans la partie de droite de la fenêtre de travail et vous pouvez 

les déplacer où bon vous semble.  

 
Figure 18 :  Fenêtre de travail de PCB Editor 

5.3.1. La fenêtre de travail de PCB Editor: 

Cette fenêtre est composée de plusieurs parties : 

La barre de titres affiche le type d’éditeur en cours d’utilisation, le type de fichier 
ouvert et le répertoire de travail actuel. 
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La barre de menus contient toutes les commandes de PCB Editor et sont 
sélectionnables avec le bouton de gauche de la souris. 

La barre d’icônes contient les outils les plus utilisés lors de la création d’un fichier. 

La fenêtre de travail est la surface dans laquelle vous allez dessiner la plupart des 
objets dont vous aurez besoin. 

La console de commandes vous permet de lancer des commandes 
manuellement mais aussi de voir apparaître des messages d’informations suite à 
une manipulation. 
La fenêtre d’état, quant à elle, affiche la commande actuellement utilisée. Le message Idle 
indique qu’aucune commande n’est active. 

Une case de couleur, à la gauche du mot « Cmd »indique l’état du système. Si celle-
ci est verte, le système est prêt, jaune indique qu’une commande est en cours mais 
qu’elle peut être interrompue (bouton Stop, touche Echap ou Ctrl+c), rouge vous 
indique que le système ne peut être arrêté. 

 

5.3.2.  Les barres d'icônes: 

Les barres d’icônes de PCB Editor peuvent être rendues invisibles, modifiées ou ajoutées en 
utilisant le menu View-*Customize Toolbar mais aussi en les déplaçant simplement d’un 
clic de souris. 
Les barres d’icônes sont regroupées par type de fonctions : 

 

File 

 

Edit 

 

View  

Add  

Display  

Setup 

 

Place 

 

Route 

 

Shape 

 

Dimension 
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Tableau 2 : Différentes partie de la barre d’icône 

5.3.3. Les panneaux de contrôles: 

Cette barre de fenêtres est située, au premier démarrage de l’outil, à droite dans la fenêtre 

générale. Les trois boutons ouvrent chacun une fenêtre permettant de régler des 

paramètres : 

•••• Options : Rassemble tous les paramètres et les valeurs des options possibles 
sur la commande en cours. (ici, commande « Add connect » active). 

•••• Find: Liste des objets sélectionnables ou non lors d’une sélection par fenêtre. Le 
choix peut être fait en entrant le ou les noms des objets. 

•••• Visibility : Contrôle la visibilité des couches de routage ou des couches 
désignées comme plans d’alimentations. 

 

 
 

 
 

  
Le bouton permet d’afficher en permanence la fenêtre dans l’environnement 

le bouton réduit la fenêtre  

Figure 19 : Panneaux de contrôle 

 

L’affichage de ces fenêtres est contrôlé aussi à partir du menu View-*Windows-* 
Find/Options/Visibility, la commande View All les rendra toutes visibles dans la partie de 
droite de la fenêtre de travail. 

5.3.4. La barre des coordonnées et commandes: 

Elle indique les coordonnées du curseur soit en mode absolu (bouton A) soit en mode 

relatif (bouton R). Le bouton Stop ne sera actif qu’à partir du moment où il sera possible 

d’interrompre une commande sinon il sera grisé. Le bouton P permet d’afficher une 

fenêtre pour entrer des coordonnées.  
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DRC indique que le vérificateur de règles est 
actif. Le texte étant à gauche de ce dernier 
indique le mode d’édition générale (GEN) ou 
simplement de cuivre (EE pour Etch Edit).

 
 

 

 

5.4. Zoom 

 

 

Figure 20 : Différents Zoom 

 

Zoom by Points : Permet de définir une nouvelle zone d’affichage en créant un cadre à l’aide 
de deux points diagonalement opposés. 

Zoom Fit : Créer une vue délimitée et aux dimensions du contour de carte. 
Zoom In : Grossit l’affichage centré autour d’un point de la carte. 

Zoom Out : Augmente la fenêtre d’affichage du dessin et diminue donc tous les éléments. 

Zoom World : Affiche la totalité du dessin dans les limites définies dans Drawing 

Extents. 
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5.4.1. La fenêtre de visualisation: 

Elle est localisée dans la partie basse du panneau 
de contrôles. Elle sert notamment à se déplacer très 
rapidement dans la fenêtre de travail en 
redessinant une fenêtre simplement à l’endroit de la 
carte où vous désirez vous rendre. Le bouton de 
droite de la souris fait apparaître un menu   

5.4.2. Touches de fonctions, raccourcis et modes d’édition : 

Ces touches de raccourcis sont paramétrées par défaut. 

Touches Commandes Touches Commandes 

F2 Zoom Fit SF2 Property Edit 

F3 Add Connect SF3 Slide 

F4 Show Element SF4 Show Measure 

F5 Show Element SF5 Copy 

F6 Done SF6 Move 

F7 Next SF7 Dehilight All 

F8 Oops SF8 Hilight pick 

F9 Cancel SF9 Vertex 

F10 Grid Toggle SF10 Save_as temp 

F11 Zoom In SF11 Zoom Previuous 

F12 Zoom Out SF12 Zoom World 

CF2 Next CF5 Color 

CF6 Color priority SCF5 Status 

Up,Down,Rigth,Left Roam x,y 
(déplacement) 

  

- 
 

Subclass- ~ Subclass ~ 

Tableau 3 : Raccourcis clavier 

5.4.3. L'onglet « Options » du panneau de contrôles: 

 
Edit4Change Route4Connect Add4Text 

 

Figure 21 : Onglet d’options 
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Cet onglet contient des options pour chacune des commandes. 

Ces images illustrent les différents changements qui peuvent survenir suivant les commandes 

utilisées. 

Les valeurs et paramètres qui sont entrés dans cette fenêtre prennent leur effet 

immédiatement et annulent les valeurs qui auraient été paramétrées précédemment 

5.4.4. La liste d'objets sélectionnables: 

Lors de sélections avec la souris pour l’édition d’éléments quels 
qu’ils soient, le réglage dans la fenêtre Find Filter du panneau de 
contrôles est fortement recommandé. 

La liste de recherche est lue du haut à gauche en descendant puis 
en haut à droite en descendant. Le premier élément sélectionné et 
rencontré lors de la sélection graphique sera utilisé. 

Cette fenêtre est probablement la plus utilisée dans PCB 

Editor. 

La partie Design Object Find Filter contient les types 
d’objets qui pourront être sélectionnés. Suivant la commande 
utilisée, certains objets peuvent ne pas être disponibles à la 
sélection. 

Les boutons All On et All Off sont pratiques pour faire une 
sélection précise et rapide d’un ou plusieurs types d’éléments. 

La partie Find by Name permet de mettre en surbrillance (Highlight) un élément ou de 
localiser un composant avec sa référence. 

Le bouton More affiche une liste des éléments sélectionnables et filtrés par la partie du 
dessus et leur nom. 

Cette liste est accessible par le menu contextuel (clic-droit) de la souris Super Filter et variera 
suivant le mode d’édition utilisé. De plus les éléments de la fenêtre FIND ne seront plus 
accessibles dès qu’un objet sera sélectionné dans le Super Filter. 

Une sélection graphique est possible en dessinant une fenêtre avec la souris et/ou avec la 
combinaison Ctrl+clic gauche de la souris. La sélection obtenue dépend évidemment des 
éléments sélectionnés dans le filtre de sélection (Panneau Find ou un seul élément dans 
Super Filter). 

Les éléments sélectionnés sont « grisés » et peuvent être édités par la commande adéquate 
choisie par vous-même. 
La sélection créée une liste accessible par le clic-droit Selection Set qui vous permettra de 
désélectionner les éléments avec Clear All Selections ou d’en sélectionner par proximité 
immédiate du curseur voire d’en désélectionner. 

Symboles : empreintes physiques (PCB Footprint) 

Nets  : équipotentielles 

Clines  : pistes de connexion électriques 

Clines segs : segments de piste 

Vias  : traversées  

Lines  : lignes graphiques 

Shapes : zones de cuivre 
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5.5. Création des pastilles 

Cette opération intervient dès lors que l’on veut ajouter des éléments dans la bibliothèque de 

pastilles, évidement, ou d’empreintes. Elle n’est pas forcément utile si l’on dispose déjà de tous ces  

éléments.  

A titre d’exemple, nous allons créer une pastille ronde avec pour diamètre extérieur 10 mm et le 

diamètre de perçage de 2,54 mm ; nous lui donnerons le nom Pad400cir100d. Il est usuel de 

travailler en mils (millième de inch et 10 mm correspond à 400 mils). Il va principalement être 

défini le diamètre de perçage (Drill), la forme de la pastille et ses dimensions. Nous éditerons une 

pastille du type Pad120cir62d et modifierons ses dimensions pour qu’elle convienne. 

 

Lancer PCB Editor. Puis dans le menu : Tools > Padstack > Modify Library Padstack. Vous 

pouvez alors ouvrir les pastilles qui sont dans la bibliothèque sélectionnée par : Setup > Users 

Preference > Design_Paths > Padpath. La bibliothèque sélectionnée par défaut est celle ou sont 

stockées toutes les pastilles à l’adresse suivante :  

C:\Cadence\SPB_16.3\share\pcb\pcb_lib\symbols 

 

Remplacer Drill diameter de 61 par 100. En cliquant sur l’onglet Layers, vous accédez au menu de 

droite. Cliquer sur la ligne BEGIN LAYER, puis modifier la Geometry et les dimensions Width et 

Height (remplacer 120 par 400). Thermal Relief définie des dimensions supérieure à la taille de la 

pastille et est destinée à limiter l’élévation thermique de la pastille. Anti Pad est la dimension de la 

pastille à proximité d’un plan de masse. 

 

 

 

Figure 22 : Fenêtre de création de pastilles (padstack editor) 
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5.6. Création des empreintes 

 

Lancer le logiciel PCB Editor. 

 

5.6.1. Visualisation d’une empreinte 

 

Pour visualiser  empreintes (Footprint), faire : Place > Manually > Advance Setting et cliquer sur 

Data Base et Library. Faire Placement List > Package Symbol. Cliquer sur le composant concerné 

et il apparaît dans la fenêtre. 

 

Résistance RES500 (5 pas) 

Diode DIO500 (5 pas) 

Capacité non polarisé CAP196 (1 pas) 

Capacité non polarisé CAPCK06 (2 pas) 

Capacité non polarisé CAP300 (3 pas) 

Transistor (2N2222) TO18 

Boîtier circuit intégré DIP8_3 

 

Boîtier circuit intégré DIP16_3 

 

Tableau 4 : géométries les plus courante de la bibliothèque de Cadence 

 

Référence PCB Foot print 
Condo chimique esiee_cap_chi_200 
Condo à 2 pas esiee_cap_200 
Condo à 3 pas  esiee_cap_300 
Résistances esiee_res_500 
Diodes esiee_diode_500 
Transistors to18 esiee_to18 
Potentiomètre esiee_pot 
CI Dip 8 esiee_dip8 
CI DIP 14 esiee_dip14 
Connect vers le FPGA 
(EL213) 

esiee_conn_basys_v2 

Connecteur 2   pastilles esiee_conn_x2 
Bornier x3 
(pour alimentations) 
 

esiee_bornier_x3_ 300mils 

LED esiee_LED_100 

Microphone (EIG1001) esiee_mic_100 

Tableau 5 : quelques empreintes de la bibliothèque ESIEE 
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5.6.2. Création d’une empreinte (en utilisant le « package wizard ») 

 

Faire File > New. Dans la fenêtre qui s’ouvre, choisir package symbole wizard. Spécifier 

l’emplacement ou elle sera sauvegardée. Suivre les indications. 

 

 
 

 

Figure 23 : Package Wizard 

Cet utilitaire permet de créer différentes sortes d’empreintes comme les Dips, Soics, Plccs, 
Bga etc.Il est possible d’en définir l’unité, le nombre de broches, espacement entre broches, 
les pastilles à utiliser...  

 

Figure 24 : Package wizard (suite) 

Il créé un fichier de dessin (*.dra) automatiquement en prenant comme modèle un autre fichier 
de dessin (*.dra) contenant les informations basiques (couleurs, taille de textes...). 

Après avoir créé un symbole d’empreinte à partir du Wizard, il est possible de le modifier en 
utilisant PCB Editor. 
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Dessin 
mécanique 

Référence sur 
sérigraphie... 

Dessin de 
sérigraphie 

Encombrement du 
composant avec 
information de hauteur 
min/max. 

Padstack 

Les paramètres de dessin: 
Cette fenêtre donne la configuration générale du fichier en cours 
d’édition. 

Le Type de dessin en cours peut être changé ainsi que les User Units 
(Mils, Inch, Microns, Mm, Cm..). 

La taille (Size) de la surface maximale de travail (A, B...ou A4, A3,...) 
ainsi que la précision (Accuracy) voulue sur cette surface. 

Les paramètres DRAWING EXTENTS indiquent immédiatement la 
taille de la surface (Width et Height) ainsi que la position de l’origine 
du dessin (Left X et Lower Y). 
Cette origine peut être déplacée en X et en Y avec la section MOVE 
ORIGIN.  

 

L'origine du dessin: 
L’origine de tous nouveaux dessins est située en bas à gauche, celle-ci doit être 
normalement déplacée sur un point précis d’une empreinte (Broche n°1, centre du 
composant). Vous devriez déplacer cette origine avant de placer des broches mais il est 
possible de le faire par la suite en utilisant l’ongelt Design à partir de Setup-*Design 
Parameters. 

 

 

Figure 25 : Composition d’une empreinte 
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5.6.3. Exemple de création d’un DIP 14 

(Extrait d’une documentation constructeur) 

 

 
 

 
' Allez dans File-*New puis sélectionnez l’option Package Symbol (wizard) dans 
le Drawing Type. ~ Tapez DIP14 puis cliquez sur OK. 

La fenêtre du Package Wizard Symbol apparaît à l’écran. 

' Sélectionnez DIP comme type de boîtier à créer puis cliquez sur Next. 

La fenêtre de modèle est affichée, elle sert notamment à charger un modèle de fichier 

.dra. 

' Sélectionnez Default Cadence supplied Template et cliquez sur Load Template puis 

sur Next. 

La fenêtre General Parameters est affichée et vous permet d’entrer les unités que vous 

désirez utiliser. 
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' Réglez les unités sur Millimeter avec une précision de 2 pour les dimensions à entrer dans 
le Wizard et pour celles utilisées pour créer le symbole. 

' Réglez le Reference Designator Prefix à U* puis cliquez sur Next. 

La fenêtre DIP Parameters 
apparaît, les champs vous 
permettront d’entrer les écartements 
de broches, les tailles du boîtier... 

~ Entrez les paramètres comme 
indiqué ci-contre : 

' Cliquez sur Next. 

La fenêtre des Padstacks est 
affichée 

Cliquez sur le bouton ‘...’ de la ligne ...Use 
for Symbol Pins puis allez chercher la pastille 150-080-C et validez ce choix.  

Cliquez sur le bouton ‘...’ de la ligne ...Use for Pin 1 et allez chercher la pastille 150-080-S puis validez ce choix.

Cliquez sur le bouton Next de la fenêtre. 

La fenêtre Symbol Compilation est ouverte, celle-ci vous permet notamment 
d’entrer l’origine du symbole mais aussi de lancer la création du symbole .psm. 

' Sélectionnez Pin1 comme origine puis activez l’option Create Symbol et cliquez sur 

Next. 

La fenêtre Summary est affichée... elle est votre dernière chance de changer des paramètres 

en cliquant sur Back... ! 

' Cliquez sur Finish, le symbole Dip14.psm est crée et le fichier Dip14.dra est sauvé dans 
le même répertoire et ouvert dans PCB Editor en mode Package. A ce stade de la conception, 
il vous sera possible de modifier ce symbole. 
 

FIN DE L’EXERCICE 
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5.7. Importer la netlist de Design Entry CIS dans PCB Editor: 

 

Lancez PCB Editor puis ouvrez le fichier carte_EL213.brd  ou EIG1001.brd (ou bien créez 
votre carte.) Allez dans le menu File => Import Logic 

    La fenêtre Import Logic est affichée. 

Choisissez l’option Design Entry CIS puis indiquez bien le chemin mon répertoire dans la 
ligne Import Directory. 

" Cliquez sur le bouton Import Logic. 

5.7.1. Partir de PCB Editor 

 

 

Figure 26 : « Import Logic » 

5.8. Conditions préalables au placement 

 

 

Figure 27 : Définition de la grille 
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Les éléments nécessaires au placement doivent être réunis pour pouvoir exécuter un 
placement efficace et pratique sur une carte.  

5.9. Placement Manuel 

La commande de placement manuel peut-être utilisée pour placer les composant en fonction de 
leur référence, de leur classe d’appartenance (IC, IO, Discrète), de leur type de boitier, de 
propriété, de leur appartenance à une room, d’un part number (Part #) ou alors en fonction 

 

Figure 28 : Listes des composants à placer 

Symbols : Les symboles d’empreintes et de pastilles demandés au travers de la netlist 
doivent exister dans la bibliothèque déclarée. Cette bibliothèque est déclarée avec 
des chemins d’accès dans le fichier env. Netlist : Une netlist doit être chargée sur le 
fichier brd. 

Alternate Package Symbols : Si vous envisagez de pouvoir utiliser d’autres empreintes sur 
un symbole, cette information doit être planifiée dans la saisie de schéma (DesignEntry CIS ou 
Capture) ou au niveau du fichier ppt (ConceptHDL®). 

Floorplanning (Découpage de la surface de placement) : Il est possible de découper la 
carte en zones fonctionnelles en utilisant des Rooms. Ce découpage peut déjà être fait à 
partir de DesignEntry CIS® ou ConceptHDL®. 

Package Keepout (Interdictions de placement) : Ces zones permettent d’interdire le 
placement de composant et ainsi de contrôler des zones sensibles. 

Il est possible avec cette commande de placer des éléments non référencés (Package 
Symbols) mais aussi des symboles « mécaniques » (Mechanical Symbols) et des symboles 
de formats de pages (Format Symbols). 

 

5.9.1. La grille de Placement: 

Menu Setup-*Grids ou clic-droit Quick Utilities-*Grids 
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La grille de placement est considérée comme une grille de type Non-Etch. L’origine du 
symbole qui va être placé se colle à la grille paramétrée. 
L’origine de la grille est celle de la surface de travail donnée dans la partie Size de la fenêtre 
Design des paramètres de dessin. 

Cette grille est rendue invisible ou visible en cliquant sur l’icône de grille. 
 

5.9.2. Les commandes de placement: 

La commande Manually est utilisée pour placer les composants un à un et déterminer ainsi 

leur 
emplacement. Les commandes de placement automatique incluent la commande 

QuickPlace qui permettra de placer les composants autour de la carte et/ou dans leurs 
rooms respectives afin de les placer interactivement par la suite. La commande Autoswap 

permute entre elles toutes les fonctions identiques qui permettront d’optimiser le routage de 
la carte. 

La commande Update Symbols met à jour les symboles présents sur la carte par rapport aux 

bibliothèques. 

Le Placement manuel: 

 

Figure 29 : Placement manuel 
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Menu contextuel de 
la souris 

 

Le choix multiple de composants à placer est possible, Allegro plaçant les composant un à un au 
bout du curseur de souris. A tous moments le menu contextuel de la commande est accessible 
par la souris pour utiliser les commandes Rotate, Mirror et Move. 
La ligne supérieure permet de choisir le mode de placement : 

Components by refdes : Ne comporte une liste de composants que lorsque la netlist est 

chargée sur la carte. Module Instances/definition : Placement des 

modules de placement (Performance). Package Symbols : Placement 

de symboles d’empreintes sur une carte. 

Mechanical Symbols : Placement de symboles comme des contours de 
cartes ou des trous de fixation.... 

Format Symbols : Pour placer les contours de pages et cartouches.... 

La section des filtres de sélection vous permettra d’appliquer des principes 
de sélections suivant des propriétés (Property, Room, Part#) voire des 
Nets. 

Place by refdes permet d’appliquer un filtre en fonction d’une classification (CLASS) et d’un 
nombre de broches. 

Lorsqu’un composant est accroché au curseur, il est possible de le placer sur une face ou 

l’autre (Mirror), de le lacher pour en déplacer un déjà placé (Move) de le faire tourner 

(Rotâtes) en utilisant les commandes du menu contextuel de la souris. 

La fenêtre de placement manuel peut-être cachée ou non en utilisant la commande Hide ou 
Show du menu contextuel. 

Changer l'orientation par défaut: 

Menu Setup-)Design Parameters ou clic-droit 
Quick Utilities-) Design Parameters 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 30 : Menu « Design parameter » 
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Lorsque le placement est en cours, les composants sont accrochés au curseur avec une 
orientation qui correspond à celle avec laquelle ils ont été conçus dans la bibliothèque et sont 
donc aussi, par défaut, placés sur la face TOP de la carte. 

Si un grand nombre de composants doivent être placés sur la face BOTTOM alors il sera 
beaucoup plus pratique d’aller cocher Mirror dans la fenêtre ci-dessus et d’indiquer l’Angle par 
défaut à utiliser avant de réutiliser la commande de placement manuel. 
La valeur Default symbol Height sera utilisée lors de l’export des données au format 
IDF sur tous les composants dont la hauteur n’a pas été renseignée. 
 

5.10. Le Chevelu 

 
Le chevelu sert à matérialiser la connexion entre deux points avant qu’une piste ne soit 
routée entre ces points. Ce chevelu peut servir à placer une carte de façon beaucoup plus 
pointue en fonction de la distribution des signaux ou en mettant en évidence une zone 
particulièrement dense dont les chevelus seraient croisés. 

 

Ces chevelus peuvent êtres colorisés de trois couleurs différentes 
suivant leurs points de départ et d’arrivée :TOP-TOP ; TOP-
BOTTOM ; BOTTOM-BOTTOM. 

Il peut être affiché ou rendu invisible suivant quatre principes de sélection : 

•••• All : affiche l’ensemble du chevelu sauf les nets portants la propriété 

NO_RAT. 

•••• Components : affichage selon les composants choisi graphiquement (avec la 
souris) ou par liste  
(avec Find By Name du panneau de contrôles) ou par fichier comportant une liste 
de références. 

•••• Net : affichage selon les équipotentiels choisis selon les mêmes méthodes que 
pour l’affichage en fonction des composants. 

•••• Of Selection : affichage suivant une sélection d’objets faites sur le dessin par la 
commande Selection Set. 

Les nets dits d’alimentations et utilisés en tant que tels dans la schématique portent de 
facto la propriété NO_RAT. 
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En utilisant Design Entry CIS : 

 

La commande Place Manually doit être active dans PCB Editor pour que fonctionne 
ce principe. 

 

Figure 31 : Lien avec CIS 

 

La sélection du composant dans Design Entry CIS (Capture) permettra de placer celui-ci 
seulement si PCB Editor est en cours d’exécution pour que la commande PCB Editor 
Select soit disponible. 

La deuxième condition à remplir est que l’option Intertool Communication soit bien 
sélectionnée dans les options de Capture. 
Il se peut que l’affichage dans PCB Editor soit redimensionné à la taille du composant 
accroché au curseur. Si tel est le cas et que l’utilisateur souhaite changer c e 
comportement, il lui faudra cocher la variable no_zoom_to_object dans la catégorie 
Input du User Preferences Editor. 
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